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1 Release Notes

Welcome  to  the  release  notes  of  VI-BikeRealTime  18.0.  The  chapter  contains  information  regarding  new
features and revision history.

Please send your comments or support requests to support@vi-grade.com.

1.1 What's New

What's new in version 18.0:

What's new in VI-BikeRealTime

What's new in VI-Animator

What's new in VI-Road

1.1.1 What's New in VI-BikeRealTime

This VI-BikeRealTime release has the following new features:

Fork angle for front suspension

The  fork  axis  can  be  not  aligned  with  the  steering  axis.  This  is  possible  using  the  fork  angle  (new
parameter) different from the head angle (available for bikes that are not conceptual).

Addtional suspension force elements

A secondary  spring and a top-out  element  are mounted both on the front  and the  rear  suspension.  The
front suspension is also provided with asymmetric/symmetric elements on the left and right side.
Each element can be activated or deactivated and the related output will appear or disappear in the result
file.

Tire limits

Tire limits  computations can be performed at  each time step of  the  analysis,  in  runtime  mode  or  post-
processing mode. The activation flag and the tire limits parameters set are available at the bottom of each
simulation tab (Testrig simulation excluded).

mailto:support@vi-grade.com
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External road

Simulations in Matlab/Simulink have a new feature: the tires can be linked to an external road.

Tire reference marker

Tire reference location and orientation are included in the simulation settings.  The simulation so can  be
adapted to use roads with any initial position and rotation.

New Figure 8 reference event

A new set of event files is included in the shared database to run a figure 8 event with 2.5 meter radius

Entries on the tree menu for the simulation event

The  Re-run  entry  allows  to  repeat  an  event  which  was  already  simulated.  This  is  useful  to  repeat  the
simulation taking into account changes in the bike model.
The Remove entry just deletes the event tree item.

Please refer to the revision history table for a summary of the addressed issues.

1.1.2 What's New in VI-Animator

Lighting settings.
Some  options  to  customize  lighting  have  been  added  to  settings.  Ambient,  diffuse  and  specular
components  and  light  direction  can  be  modified.  Lighting  settings  are  persistently  stored  just  like  other
options.

Toolbar to simplify building calculated component expression.
On the dialog to create a calculated component  now the user can find a toolbar  to  simplify  the  writing  of
some popular expressions:  constant  channel,  move a channel to origin,  adding and subtracting channels,
scaling, differentiate and integrate a channel and FFT calculation.
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1.1.3 What's New in VI-Road

Here is the list of the main new features available in this release of VI-Road:

Support for Google KML file format:
Google  maps  allows  to  export  custom  road  definition  in  KML/KMZ  format.  This  file  format  can  be  now
imported in VI-Road and will be handled then as a measured road or a path.

Road Mesh materials visualized, modified and exported:
Materials  defined  in  rdf  files  for  Mesh  roads  are  visualized  with  different  colors.  Road  materials  can  be
modified and then exported in Wavefront file format as well.

Create driver line by hand picking way points:
Driver lines can be created for every type of road just picking the points where the path should go.

OpenCRG support improvements:
Starting with this  version of VI-Road the user can choose  to  apply  modifiers  on  load,  apply  then  a  rotation
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and/or translation just like other types of road, and then save the resulting file in OpenCRG format as well.

Driver line offset tool:
A dedicated panel  has  been  added  to  apply  an  offset  to  an  existing  driver  line.  The  offset  value  can  be  a
constant or specified by a table.

1.2 Licenses
VI-BikeRealTime 18.0 requires following set of license keys:

VI_Bike_Core
VI_Bike_IFace
VI_Driver_EventBuilder
VI_Rider_Basic_Core
VI_Tire_Core
VI_Tire_Toolkit
VI_Tire_TireLimits
VI_Road_Core
VI_Road_Toolkit

The Maximum Performance Moto module requires the additional license key:
VI_Rider_Advanced_Core
VI_Rider_External (only for the Matlab version)

The Press Maneuver Event required the additional license key:
VI_Bike_PressManeuver

Please  make  sure  that  you  are  running  VI-grade  Licensing  version  18.0  or  newer  (based  on  LMX server
version 4.6.5 or newer).
Please look at VI-Licensing.pdf document for a detailed description of VI-grade’s licensing system and how to
setup a license server.

VI-BikeRealTime is based in part on the work  of the Qwt project  licensed under the LGPLv2.  The Qwt library
version used is 6.1.0 and can be downloaded here.

http://sourceforge.net/projects/qwt
http://sourceforge.net/projects/qwt
http://www.gnu.org/licenses/old-licenses/lgpl-2.0.html
http://sourceforge.net/projects/qwt/files/qwt/6.1.0
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1.3 3rd Party Compatibility
This table shows the compatibility of the VI-grade suite products with the main 3rd party software.

VI-CarRealTime VI-BikeRealTime VI-DriveSim
VI-Driver

for Matlab

VI-Driver

for FMI

Matlab® 
from 2013b to

2016b

from 2013b to

2016b

from 2013b to

2016b

from 2013b to

2016b

VeristandTM (***) 2015sp1 2015sp1

dSPACE® RCP & HIL 2014b,2015b 2014b,2015b 2014b,2015b

SimWorkBench® 2017.1 2017.1 2017.1

xPC® 2012b

Dymola® 2015 2015

MapleSimTM 2015

CarSimTM 8.1.1, 9.0

Virtual Test Drive® 1.4

Prescan® 7.3

SCANeR® 1.6.74

ETAS 

LABCAR-OPERATOR IP®
5.4.0

SolidThinking

Activate
2017.1

3rd Party Software included in VI-grade products:

VI-CarRealTime VI-BikeRealTime VI-DriveSim
VI-Driver

for Matlab

VI-Driver

for FMI

FTire 2017-2 2017-2

MF-Tyre/MF-Swift
6.2.0.3 

7.1

6.2.0.3

7.1

6.2.0.3

7.1

The following table shows the 3rd party compatibility for Adams-based VI-grade product: 

VI-Motorcycle VI-Automotive VI-Rail VI-Aircraft
VI-CarRealTime

Plug-In
VI-Driver

MSC AdamsTM 2017 2017 2017 2017
2015.1, 2016, 

2017, 2017.1

2015.1, 2016, 

2017, 2017.1

Matlab® * * * *

(*): please refer to Adams documentation for compatibility version.
(***)  The  NI-PXI  integration  requires  Visual  C++  2010  /  SDK  7.1  to  complete  the  building  procedure
successfully. Please refer to the NI-VeriStand documentation for more detail. 

The VI-Licensing LMX supported version is 4.6.5 both for Server and for Client.
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1.4 Platform Support
VI-BikeRealTime 18.0 is available for the following platforms:

Platform Installer Name

windows x64 VI_BikeRealTime_18_0_x64_Setup.exe

This installer is compatible with:
windows 7 x64
Windows 10 x64

Please  note  that  this  version  of  VI-BikeRealTime  is  released  exclusively  for  64  bit  OS.  Solver  modules  are
available through the 32 bit  overlay  in case you need to operate VI-BikeRealTime in combination with 32  bit  3rd
party tools like Matlab/simulink.

Specific overlays are available for supporting the following hardware in the loop platforms:

dSPACE
ds1006 r2014b/r2015b

VI_BikeRealTime_ds1006_18_0_r14b_Setup.exe

National Instrument
Veristand and LabView

VI_BikeRealTime_ni_pxi_18_0_x86_Setup.exe

The  Concurrent  SimWorkbench  environment  is  also  supported.  Please  contact  VI-grade  support  to  request  a
customized version of VI-BikeRealTime for this environment.

1.5 Known Issues
No issues are known at release time.

1.6 Updating Models
Updating to version 17.0

Updating to version 16.0

Updating to version 15.0

Updating to version 14.0

1.6.1 Updating to version 18.0

The following key  in  the  VDF  file  is  now affecting  also  open  loop  throttle  signal  while  in  past  version  only
machine mode was affected.

THROTTLE_CONTROL_ACTIVATION = 'TRUE'

the consequence is  that  during a gearshift,  the  throttle  will  be  released  also  when  configured  in  open  loop
mode. 
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1.6.2 Updating to version 17.0

No changes are required to v16 models

1.6.3 Updating to version 16.0

No changes are required to v15 models

1.6.4 Updating to version 15.0

The upgrade of models  from the v14.0 (or older) to the current  version is  automatically  performed  except  for
some updates in Simulink models which has to be done manually.

The current  version of VI-BikeRealTime adds a redesigned Matlab/Simulink  interface respect  to the  previous
release. The Simulink models created with the previous version have to be updated replacing the old interface
with the newer one (retrievable under the VI-BikeRealTime Simulink library).

Please refer to the Matlab interface model migration topic for more details on models migration.

1.6.5 Updating to version 14.0

The  migration  of  models  from  the  v13.0  to  the  current  version  is  done  automatically  except  for  a  few
modifications that need to be performed manually.

VI-BikeRealTime Graphical Interface

After you have registered your v13.0 database into a v14.0 session and you attempt to open bike model in the
GUI, you will get the following error message:

this is the consequence of the new name convention assigned to the models  table in the database (changed
from  vibrt_models.tbl  to  model.tbl).  In  order  to  open  the  xbk  file  you  simply  need  to  browse  for  the
vibrt_models.tbl folder of the database using the standard folder navigation buttons of the open file dialog box.
If you don't  need to preserve v13.0 compatibility,  you can also rename the vibrt_models.tbl folder to models.
tbl.

Matlab/Simulink Interface

The current  version of VI-BikeRealTime adds several more simulink  input  and output  respect  to the  previous
release, so when you try to run Simulink models  created with v13.0 in combination with the VI-BikeRealTime
latest mex function, you will get errors similar to the following ones:
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In order to fix this issue you need to upgrade your mdl files in order to include an S-Function block compatible
with v14.0. You can get the correct Input, output  and S-Function blocks from the vibrt.mdl included in the VI-
BikeRealTime installation folder.

Please make sure that  all  blocks  contained  in  the  Inputs  and  Outputs  blocks  are  aligned  to  the  v14  ones
before running the VI-BikeRealTime Matlab interface.

1.7 Revision History
Version Change

ID
Change

v18.0 5516 Fixed contextual menu on the property file field

5437 Output remove of deactivated suspension elements 

5332 Support for external road model

5326 Fixed crash executing tree menu with multiple selection

5324 Removed useless yaw PID activity flag 

5321 Fixed yaw crc controller that was not reset

5256 Run action on simulation event tree menu

5254 Fixed widget signals in VI-Animator

5244 Xgr as road graphics file

5241 Handlebar maximum rotation angle

5173 Tire limits runtime

5154 Fork angle separate from steer angle

4996 Fixed crash in MaxPerfMoto simulation with high initial speed 

4974 Asymmetric elements for front suspension

4939 Results file from static SpeedGenMoto simulation

4923 Simulation specific log file

4709 Tire reference parameters

4653 Top-out element for front and rear suspension

4652 Additional (secondary) spring

 3770 Option for writing the results file of the static analysis

3330 Simulation event remove

1574 Create database functionality
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v17.1 5120 Standalone executable fails to report driver computaton errors during dynamics 

5116 Low Speed Control deactivation does not turn off eternal balance torque

5115 Add support for figure eight event

5114 Steering states mismatch during solver derivation call

4710 Improve rider computation efficiency on press maneuver 

3948 New HIL overlay for Concurrent 

v17.0 4919 MaxPerfMoto: implement a recovery strategy in case of VI-Rider computation failure

4911 Hardcoded integration step for SpeedGenMoto static analysis

4884 Uninstallers fails on Windows 10 (message: "files are locked")

4858 Conceptual bike save & restore failure when steer torque flag is active

4842 User sensor computation frequency should match solver one

4818 Steering instability at low speed

4806 Vibrt locks matlab in case of wrong property file path

4690 Toolbar icon not selected at startup

4689 "Close All" item never enabled in File Menu

4680 MaxPerformanceMoto crash after equations of motion failure

4639 Plot configuration file missing running a simulation review

4638 Advanced option to choose spline interpolation type

4637 Add support for dSPACE release 2015

4622 Expose testrig steer min/max parameters

4621 VI-SpeedGenMoto with dynamic event enabled doesn't write res file

4585 Export bsf file for testrig simulation

4582 PSD irregularities computations enhancements

4578 MaxPerformanceMoto and PressManeuvers don't write results

4538 Bike Schema dialog can not be closed

4347 Differences between simulink and standalone version

4336 KeepFiles option doesn't work in MaxPerformanceMoto for Matlab

4296 Vehicle.CM_global_vel/acc requests are ill-defined

4269 Enable crg load from road widget

4243 Support for luggage parts

4165 Gravity option for acceleration sensors

4160 Improve user sensors documentation

4157 VI-Tirelimits is not accessible from VI-BikeRealTime

4151 Implement "reversed" skidpad shape

4138 New general simulation tab, new simulation settings, added steering torque front suspension, improved
clutch definition.

4133 Eds crash if roll is over the threshold in the last segment

4131 Wrong termination after mxp failure

4130 Expose "max iteration" parameter for maximum performance simulation

4093 Vdf template shipped is wrong

4073 Ride height ref plane angle not saved

4069 Press maneuver event

4024 linear spring not load correctly from xbk

3966 Add external inputs to manage vidriver openloop signals

3947 Add the possibility to change gear number

3946 Add an external input for pinion torque
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3937 Save as of property file editor does not show db list

3830 Intgrate resreader utility

3789 Conceptual model does not support stability events

3788 Support steering torque feedback

3774 Incorrect FileDialog on "save as" from property file editor

3739 Add Disk/Caliper number parameter for braking system

3738 Improve brake system documentation

3715 Add steering damper to front suspension

3673 Memory exception usign a wrong license file on dSPACE target

3665 "widgets.xgr" file in vibrt_shared database does not contain throttle and brake bars

3661 Couldn't edit calculated components after a live animation

3659 Integrate MF tyre libraries

3646 Write program version in exported bsf file

3331 Different simulation events with the same name

3230 Brt accessories are installed in default directory

3005 Wrong size speedgen map is not managed

2705 Bike name bar loose color without focus on BRT window.

2570 Live animation should be started when requested even if animator is not found

2363 Fix final ratio when chain is disabled

2332 Circ/diam label in powertrain tab is not clear

2285 Contextual menu on tree view bike object

2263 Optional env variable to specify additional applications install dir

1912 MaxPerformanceMoto initializes VI-SpeedGenMoto on every iteration

1424 Run solver in separate thread

1288 Save database configuration in a cfg file

1094 Chenge location of the clearance field for a bumper

1077 Using Steering torque as external input

v16.1 3779 Add tire termination after statics failure

3778 Show max RPM in powertrain plot

3756 Add maneuver switch at runtime

3740 Fix DS1006 multi core application build

3724 Remove memory leak during solver execution

3722 Restore units conversion after parameter change

3719 Restore speedometer longitudinal velocity in live animation

v16.0 3587 Prevent cloning simulation events with the bike

3536 Steering torque computation flag needs to be set from GUI

 3441 Need to set sprung and unsprung mass for conceptual suspensions

3403 Hold Simulink output when the simulation is stopped

3351 Add the possibility to run VI-EventBuilder from the Tools menu

3350 Add the possibility to run VI-Road from the Tools menu

3349 Add the possibility to run VI-EventBuilder from the vdf file field

3534 Add activity flags for spring, bumpstop and reboundstop in Simulink

3231 Show a message if VI-Animator is not found

3030 Rider body should be moveable

3029 Need to run MaxPerformanceMoto Events in Simulink

2698 Could not postprocess two events of same type
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v15.0 2818 Support for Matlab 64 bit

2747 Road graphic is shown in VI-Animator even if not requested

2727 Support editing of VDF template for MaxPerformanceMoto event

2686 Model is not updated after saving a property file with a new name

2677 Could not change tire USE_MODE after first interactive simulation

2684 Could not save a property file after canceling a save as operation

2568 Support execution of VI-Animator from BikeRealTime GUI

2603 Simulation run button is not accessible on lower screen resolution

2581 Gear teeth number is not stored in the bike file

2565 BSF file miss live animation information

2548 Missing documentation about gyro reference system

2546 Solver may crash on termination after failed simulation

2499 Support for dSPACE platforms

2427 Support for NI-Veristand environment

2426 New Matlab/Simulink interface 

2370 Flying lap option for VI-SpeedGenMoto event

2343 Support user defined sensors

2628 MaxPerformanceMoto event may fail on 3D measured road

2468 Too strong reaction from longitudinal controller to pitch movements

2447 Gear shifting parameters defined as function of path_s

1496 Export geometry from VI-MotorCycle model

1044 Brake demand increases when a downshift occurs

v14.0 2346 Some bike parameters are not clearly documented

2336 Create additional output file format like CSV, Matlab and PI 

2289 Interactive mode does not produce simulation statistics

2267 VI-BikeRealTime GUI does not produce any log file

2257 Support graphical animation of the bike model

2251 Use VI-Animator as plotting environment

2154 Support Interactive/files_only mode based on BSF file for all events

1992 Allow side by side installation of different VI-BikeRealTime version

1911 Results mismatches repeating the same simulation

1815 Missing data  in 3D spline editing panels

1766 Standardize model directory to models.tbl instead of vibrt_models.tbl

1759 Support dynamic update of output bus for simulink models

1758 Support parallel execution of internal and external engine model

1638 Support clutch back torque saturation effect

1576 Support user defined output step for interactive analysis

1570 Example simulink model active_vibrt fails when external dampers are on

1547 Friction scaling input in matlab is not affecting tires

1527 Support a quick connection fo VI-Road for editing RDF files

1519 Memory leaks running on Meshed road

1515 Problems with static analysis on 3D road

1510 Missing target path coordinates in simulation output

1506 In some cases VI-Rider EDS neglects the MIN_ACTIVE_TIME parameter

1505 Support six component force input to the chassis 

1500 Support remote connection to VI-Animator (Live animation mode)
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1498 New event for speed profile computation (VI-SpeedGenMoto)

1425 Matlab crash when initial gear is not compatible with engine speed limit

1423 VI-Rider license not released at the end of interactive simulation 

1416 simulations are not stopped when event files is wrong

1375 pinion output speed is not included in the output set

1374 gear teeth maximum value is too strict

1316 failure running a database from a directory including brackets

1314 No warning trying to set working dir to a non existing folder

1153 GUI labels for inertia tensor are not clear

1108 Prevent loading of multiple models with the same name

1097 Missing documentation for reference swingarm legnth parameter and right height reference frame for
conceptual suspension

883 Improve solver error messaging

v13.1 Added the Conceptual Bike model

v13.0 Base Package
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